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Einführung 
 
 
 
Willkommen zu Flame Painter!  
 
Flame is ein Malprogramm, mit welchem Sie originale Kunstwerke, Lichteffekte, 
unkonventionelles Design oder phantastische Hintergründe mit Flamme Bürsten ganz einfach 
kreieren können. 
Es wurde als ein Experimentierprojekt in meiner Serie "I am an Artist" entwickelt. Meine erste 
Version sollte ein Programm sein wo jeder etwas Schönes gestalten konnte. Flame sollte ein 
Werkzeug sowohl für den Künstler als auch für Leute ohne künstlerisches Talent sein, die was 
Einzigartiges gestalten wollen.  
 
Der Mangel an Inspiration ist oft der Grund warum Menschen nicht kreativ sind, jedoch können 
die Werkzeuge die wir nutzen eine Quelle der Inspiration sein. Mit jedem Werkzeug, das einen 
inspiriert, kann jeder zum Künstler werden. Darum wurde Flame Painter geboren!  
 
Dies ist die dritte Version von Flame Painter. Es gibt viele neue Features enthalten - Flame 
Painter Connect - ein Photoshop-Plug-in, das als Live-Verbindung zwischen Flame Painter und 
Photoshop funktioniert; die Fähigkeit, Wacom-Tablett Druckempfindlichkeit und Leap Motion-
Kamera zu verwenden; einen reibungslosen Import und Export von PSD-und SVG Vektor-
Dateien. Die Multi-Core-Engine, der neue hochauflösende Renderer und Photoshop-
Füllmethoden haben diese Software ein leistungsfähiges Werkzeug für die Erstellung von 
professionellen Kunstwerke gemacht. 
 
Diese Bedienungsanleitung behandelt die Features des Programms und erläutert, was man 
alles wissen muss, um mit Flame Painter malen zu können. Es gibt eine schöne Auswahl an 
Pinselparameter ‐ experimentieren Sie mit unterschiedlichen Pinseleinstellungen und vielleicht 
finden Sie einen neuen kreativen Weg der Selbstdarstellung!  
 
Danke, dass Sie Flame Painter erworben haben. Ich hoffe Sie haben viel Spaß mit dem Malen! 
 
                Peter Blaškovič 
         Entwickler von Flame Painter 
  

http://www.psd-tutorials.de/forum/threads/wacom-bamboo-druckempfindlichkeit.66615/


Benutzeroberfläche 
 

 

Werkzeuge 
 
 

Brush / Pinsel – Wählt den Pinsel aus 
Pen / Kuli - Wählt den regulären Kuli aus 
Eraser / Radiergummi – Wählt das Radiergummi aus 
Fill / Füllen – Wählt das Füllwerkzeug aus 
Transform / Transformieren - Verschiebt und skaliert 
die ausgewählte Ebene 
Edit Vector Layer / Vektorebene bearbeiten - Der 
Bearbeitungsmodus für die ausgewählte Vektorebene 
 
Zoom Out / Rauszoomen – aus dem Bild 
herauszoomen (bis 5%) 
Zoom In / Einzoomen – in das Bild reinzoomen (bis 
800%) 
Reset Zoom / Zoomfaktor zurücksetzen – Bitte 
Zoomwert überprüfen. Beim Click auf diesem Button 
wird auf 100% gezoomt. 
Undo / Rückgängig – Letzten Schritt rückgängig 
machen 
Redo / Wiederholen – Zürückgenommene 
Bildänderung wiederholen 
 
  



Brush / Pinsel 
 
Es stehen drei Malmodi zur Verfügung: 
 
Flame – Der klassische “Flame” Malmodus 
Follow / Verfolgen – Der Pinselstrich verfolgt den Mauszeiger genauer, eine zeilenbasierte 
Pinsel 
Ribbon – Der Malmodus “Schleife”, der Strich verbreitet ein bisschen breiter. 
 
Blending / Füllmethode – Farbfüllmethode. Es stehen drei Farbfüllmethoden zur Verfügung:  
- Normal für das Standardmalen,  
- Lighten / Aufhellen (additiver Modus) wird typpischerweise für Lichteffekte auf dunkle 
Hintergründe und  
- Darken / Abdunkeln (subtraktiver Modus) für lichteffekte auf hellen Hintergrundfarben. 
 Opacity / Deckkraft – Pinseldeckkraft (0 - 100) 
 
Pinselparameter Flame, Follow und Ribbon  
 
Mit folgenden Pinselparametern können Sie experimentieren: 
 
Size / Größe – Pinseldurchmesser, Anzahl der malenden Pinselpunkte (1 – 300) 
Span - Pinselbreite (0 – 10) 
Dist – Pinselpunktabstand (1 – 20) – wählbar, wenn "Lines" mit "On"aktiviert ist 
Soft / Härte – Pinselhärte (1 – 100), mehr globaler Pinseleffekt 
Speed / Geschwindigkeit – Pinselgeschwindigkeit (1 – 100), Reaktionsdauer des Pinsels; je 
höhere Geschwindigkeit, desto genauerer Pinsel 
Center / Stärke – Globale Kräfte (0 - 100) 
Focus / Fokus  - Lokale Kräfte (0 – 100) 
Chaos – Chaos-Parameter (0 – 100), wie chaotisch Pinselpunkten oszillieren um einem Pinsel 
Noise / Rauschen – Rausch-Parameter (0-100), je höhere Nummer, der Pinsel desto 
geräuschvoller. 
 
Alle diese Parameter sind in gegenseitiger Korrelation. Jede Einstellung beeinflusst, wie das 
Ergebnis aussehen wird  
 
Fade / Blenden – Ein- und Ausblenden (0-10). Einstellen des Blendzeitpunktes 
Fill | Lines / Füllung | Linien – Wechsel zwischen den Modi "Fill" und "Lines" 
Detail - Pinselstrichdetail (1-4). Stellt die Details des Flammenpinselstrichs ein. Ein höherer 
Wert kann wegen der Rechenintensität zu einer Verlangsamung des Programms führen. 
Höhere Werte sind gut für weiche Pinselbewegungen oder wenn das Bild sehr groß ist.  
Bem.: Es ist rechenintensive Parameter; wenn die Parameter höher eingestellt ist, kann die 
Malerei sich verlangsamen 
Antialiasing (AA) – Wechsel zwischen "Normal Antialiasing" (Normales Antialiasing) und 
"Supersmooth Antialiasing" (superweiches Antialiasing) 
Bem.: Der Parameter "Supersmooth Antialiasing" kann wegen höherer Rechenintensität zu 
einer Verlangsamung des Programms führen. Diese Funktion nur in der Pro-Edition erhältlich. 
  



Pen / Kuli Pinsel 
 
Parameter: 
 
Blending / Füllmethode – Farbfüllmethode. Es stehen 
drei Farbfüllmethoden zur Verfügung:  
- Normal für das Standardmalen,  
- Lighten / Aufhellen (additiver Modus) wird 
typpischerweise für Lichteffekte auf dunkle 
Hintergründe und  
- Darken / Abdunkeln (subtraktiver Modus) für 
lichteffekte auf hellen Hintergrundfarben. 
Size / Größe - Pinseldurchmesser (1 – 200) 
Hardness / Härte – Härte des Kuli-Pinsels (0-100) 
Step / Schritt – Schritt des regulären Pinsel (0-100) 
Opacity / Deckkraft – Deckkraft des Pinsel (0-100) 

 
Benutzen Sie nur mit "Color" (Farbe), "Gradient" (Farbverlauf) ist im Basic Pinsel Modus nicht 
erhältich. 
 
 
 

Eraser / Radiergummi 
 
Parameter: 
 
Size / Größe – Größe des Radiergummis(1-200) 
Hardness / Härte – Härte des Radiergummis (0-100) 
Step / Schritt – Schritt des Radiergummis (0-100) 
Opacity / Deckkraft – Deckkraft des Radiergummis (0-
100) 
 
 
 
 
 

 
Fill / Füllwerkzeug 
 
Man kann die Ebene mit "Color" (Farbe) oder 
"Gradient" (Farbverlauf) füllen. Beim Farbverlauf kann 
man die vertikale oder horizontale Orientierung 
einstellen. 
 
Vertical |Horizontal – Wechsel zwischen "Vertical" 
und "Horizontal" Farbverlaufsfüllung  



Transform Layer 
 
Bewegen und skalieren Sie die ausgewählte Ebene. 
Klicken Sie auf OK, um die Änderungen zu akzeptieren, 
oder brechen Sie mit Cancel ab. 
Wenn Sie die Vektorebene transformieren und 
bearbeiten möchten (in Pro-Edition), klicken Sie auf die 
"Edit Vector Layer" - Taste. 

 
 

Edit Vector Layer / Vektorebene bearbeiten - 
Pro version 

 
Paint Tool / Malwerkzeug – Neuer Pinselstrich. In 
Vektorebenen nehmen nur einen Pinselstrich auf. 
Edit Tool / Bearbeitungswerkzeug - 
Schlüsselknotenpunkte bearbeiten (gelbe Punkte), um 
den Vektor zu mofidizieren. Auf die grauen 
Knotenpunkte klicken, um sie zu 
Schlüsselknotenpunkten (gelb) zu verändern. 
Group Edit Tool / Gruppenbearbeitungswerkzeug -- 
Mehrere Schlüsselknotepunkte bearbeiten (gelbe 
Punkte). 

Add & Remove Tool / Hinzufügen und Entfernen - (Tastenkürzel: STRG) Bearbeitbare 
Knotepunkte aus der Flammenlinie entfernen. 
Curve Transform / Kurvenbearbeitung – Größe, Drehung und Skalierung des Pinselstrichs 
anpassen.  
Init Curve Transform / Anfangskurve anpassen – Größe, Drehungs und Skalierung der 
Anfangskurve des Pinselstrichs anpassen. 

 
Vektorebenen besitzen den Vorteil, dass man sie bearbeiten kann. In der Vektorebene kann 
man einen Pinselstrich malen und anpassen. Nach dem Pinselstrich kann man jeden 
Pinselparameter, Verlaufsmodus, Deckkraft, Farbe, Farbverläufe nachträglich verändern. Es ist 
ebenso möglich, andere Pinselvoreinstellungen zuweisen. 
 
Bem.: Bitte beachten Sie, dass nachdem Sie einen neuen Strich in einem Vektor-Schicht 
erzeugen, wird die vorherige gelöscht. Eine neue Vektorebene für jeden editierbaren Strich 
empfohlen. 

  



Farbfenster 
 
 
Color | Gradient – Auswahl der Füllmethode. Eine Farbe oder mit einem Farbverlauf. 
 

Color / Farbe 
 
Pinselfarbe auswählen. 
 
H – Farbton (0 - 359) 
S – Farbsättigung (0 - 255) 
L – Helligkeit (0 - 255) 
 
Palette – Farbe auswählen 
 
(+) (-) – Farbfeld hinzufügen oder entfernen. 
 
Ein einzelner Mausklick auf einem Farbfeld öffnet die 
Farbauswahlpalette. 
Die Farbe könnte in den Modi Aufhellen (Lighten) oder 
Abdunkeln (Darken) sich von der Pinselfarbe 
unterscheiden! Besteht der Wunsch nach der exakt 
gleichen Farbe, sollte der Malmodus Normal 
ausgewählt werden. 

 
 

Gradient / Farbverlauf 
 

Wählen sie einen Farbverlauf und klicken Sie  auf die zu 
ändernde Farbe unterhalb des Farbverlaufs. Einzelne 
Farben des Verlaufs können ein- bzw. ausgeschaltet 
werden. 
 
Rotate – Farbverlauf drehen 
Flip – Verlaufsübergang spiegeln 
 
H | S | L – ändert Farbton, Sättigung und Helligkeit 
aller Farben im Verlauf. 
 
Length / Farbverlaufslänge – Wählen Sie, ob Sie den 
Farbverlauf an die Pinselbreite anpassen oder die 
Länge des Farbeverlaufs verändern möchten. (1-10) 
Je höhere Nummer, desto wechseln die Verlaufsfarben 
häufiger. 
 

(+) (-) – Farbfelder oder Farbverläufe hinzufügen bzw. entfernen.  



Brushes Panel / Pinselvoreinstellungen 
 
Die Palette enthält Pinselvoreinstellungen. Ein Abspeichern neuer Voreinstellungen ist möglich. 
 

Use brush palette – aktivierte Voreinstellung 
aktivieren 
Use brush blending – Füllmethoden (normal, lighten 
oder darken), die im Pinsel gespeichert sind, 
aktivieren. 
 
Share Brush - laden Sie Ihre Pinseln in der Online 
Brushes Gallery. Klicken Sie auf “Yes” zur Bestätigung. 
 
(+) (-) – Hinzufügen oder Entfernen von 
Pinselvoreinstellungen. 
 
Eine neue Pinselvoreinstellung wird durch das 
anklicken des (+)  abgespeichert. Das Icon selbst wird 
bemalt. Das Abspeichern erfolgt nach der Eingabe des 
Namens der Pinselvoreinstellung. Diese wird in der 
Palette sofort sichtbar. 
 
 
 
 

Bem.: Wenn Sie den Pinsel im "Abdunkeln" Modus speichern wollen, steht nur der weiße 
Hintergrund zur Verfügung. Beim "Aufhellen" Modus ist nur der schwarze Hintergrund 
verfügbar. 
 
Es ist möglich die neuen Pinseln direkt aus der Brushes Webseite nach Flame Painter ziehen 
und ablegen (Drag & Drop Funktion). Link auf mehrere kostenlosen Pinseln: 
http://www.escapemotions.com/products/flamepainter/brushes/index.php 
 
  

http://www.escapemotions.com/products/flamepainter/brushes/index.php


Layers Panel / Ebenenfenster 
 
 
Man kann mehrere Ebenen übereinanderpositionieren. 
 

Blending – 22 Photoshop Ebenenmoden: Normal, 
Darken, Multiply, Color Burn, Linear Burn, Lighten, 
Screen, Color Dodge, Linear Dodge, Overlay, Soft Light, 
Hard Light, Vivid Light, Linear Light, Pin Light, Hard Mix, 
Difference, Exclusion, Hue, Saturation, Color, Luminosity 
und Subtract mode. 
Opacity – Deckkraft der Ebene (0-100%) 
Eye / Augenicon – Ebene sichtbar oder unsichtbar 
machen 
Clean Layer – Ebeneninhalt leeren. 
Export to "PS" – Ausgewählte Ebene zum Photoshop 
exportieren. Sie finden weitere Informationen zu Flame 
Painter Connect - das Photoshop Plug-in nachher in 
diesem Manual. Diese Option steht nur in der Pro 
Version zur Verfügung. 
 

New Layer – Neue Ebene hinzufügen. 
New Vector Layer – Neue bearbeitbare Vektorebene hinzufügen. Diese Option steht nur in der 
Pro Version zur Verfügung.  
 
Duplicate Layer – Aktive Ebene(n) duplizieren. 
Merge Layers – Mehrere Ebenen auf eine Ebene reduzieren. 
Remove Layer – Aktive Ebene(n) löschen. 
 
Sie können die aktive Ebene mit einem Doppelklick im Layer-Liste umbenennen. 
In der Menüleiste, es ist möglich die Vektorebene zu Bitmap konvertieren. 
 
Die Farb-, Pinsel- und Ebenenfenster sind andockbar - es ist möglich die Fenstern zu 
modifizieren, Positionen zu ändern und die Breite anzupassen. 
 
 
  



Die Menüleiste 
 
File / Datei - enthält Elemente im Zusammenhang mit Laden, Speichern, Exportieren und 
Veröffentlichen Ihrer Bilder. 
Edit / Bearbeiten - enthält Elemente im Zusammenhang mit Editierung des Malenprozesses 
und die Leinwand. 
Tools / Werkzeuge - enthält Elemente im Zusammenhang mit den Malwerkzeuge und die 
Leinwand 
Layer / Ebenen - enthält Elemente im Zusammenhang mit den Ebenen 
Filter – enthält Elemente im Zusammenhang mit der Bildfilterung und den Effekten. 
View / Ansicht - enthält Elemente im Zusammenhang mit den Ansichtsfenster. 
Window – enthält Elemente im Zusammenhang mit der Benutzeroberfläche. 
Help / Hilfe - enthält Elemente mit welchen Sie die Anwendungshilfe bekommen, neue 
Updates auf die Webseite. 
 
 

File Menu (Datei) 
 
New... / Neu… - Erzeugt ein neues Bild mit neuen Einstellungen. 
Open... / Öffnen…  - Öffnet ein gespeichertes Bild. 
Save / Speichern - Speichert das aktuelle Bild. Wurde das Bild noch nicht gespeichert, wird 
nach einem neuen Namen gefragt. 
Save As… / Speichern unter… - Speichert das aktuelle Bild mit einem neuen Dateinamen. 
 
Import… / Importieren… - Öffnet ein Bild als neue Ebene. Das Bild wird automatisch 
entsprechend der aktuellen Bildgröße skaliert. Es ist möglich, es zu jeder Grösse bewegen und 
ändern. 
 
Export layer to SVG… - Sie können aktive Vektorebene als Polygone zum skalierbaren 
Vektorgrafikformat exportieren. Stellen Sie die Anzahl den Polygonen mit Detail-Schieberegler  
1-4. Diese Option steht nur in der Pro Version zur Verfügung. 
 
Bem.: Wenn der Vektor-Ebene besteht aus 100 000 Polygone und Details auf 1 gesetzt ist, 
rendert und speichert es 100 000 Polygonen. Wenn es auf 2 gesetzt ist, es vervierfacht die 
Anzahl der Polygone, so dass die Anzahl der Polygone 400 000 ist. Wenn es auf 3 gesetzt ist, ist 
die Nummer 1 600 000. Wenn es auf 4 gesetzt ist, ist die Anzahl der Polygone 6 400 000. 
 
Publish… / Veröffentlichen... – Veröffentlicht das Bild auf der Flame Painter Galerie im 
Internet. Ein Fensterdialog fragt nach dem Namen des Bildes mit der optionalen Angabe einer 
Beschreibung und Stichwörter.  
Publish Preferences... / Voreinstellungen veröffentlichen – Ein Untermenü mit Galerie-
Voreinstellungen. 
 
 



Preferences… / Präferenzen... - Safe Boundary, Wacom Tablet and Leap Motion präferenzen 
einstellen 
- Safe Boundary - Sie können eine erweiterte Leinwand mit sichtbarer Platz als die 
Leinwandgröße festlegen. Sie können eine Sichtbarkeit ein-und ausschalten und die Größe und 
Deckkraft einen sicheren Rahmen setzt. 
- Wacom Tablet - Einstellungen für die Arbeit mit Tablets, die Stiftdruck-Empfindlichkeit 
unterstützen. Sie können Intensität der Parameter einstellen, die von dem Stiftdruck 
beeinflusst sind. 
- Leap Motion - Einstellungen für Leap Motion-Controller. Es ermöglicht Malerei mit der 
Verwendung der Bewegungssteuerung einer Hand. Wählen Sie Shift-Taste mit einem Finger zu 
malen - mit "Shift"-Taste als Maustaste; oder wählen Sie Show Two Fingers, mit zwei Fingern 
zu malen. 
 
Quit / Beenden – Flame Painter schließen. 
 
Siehe auch Kapitel „Erzeugen, Öffnen und Speichern von Bildern“. 
 
 

Edit Menu 
 
Undo / Rückgängig – Letzten Schritt rückgängig machen. Die maximale Anzahl an Rückgängig-
Schritten beträgt entweder 100 oder je nach Speichergröße des Computers. 
Redo / Wiederholen – Letzten Schritt wiederholen. 
 
Image Size… -/Größe des Bildes ... - Ein Untermenü enthält Breite, Höhe des veränderten Bild 
in Pixel und der sichere Rahmen in Prozent.  
Beispiel: Wenn Sie ein Bild mit der Größe 1200 x 1200 Pixel und sicherem Rahmen auf 10% 
gesetzt zu erstellen, ist die Größe der sichere Rahmen 120 Pixel.  
 
Kreuzen Sie Keep Aspect Ratio (Seitenverhältnis) wenn Sie das Bild mit dem gleichen 
Seitenverhältnis wie das aktuelle Bild ändern möchten. 
 
Beispiel: Wenn die aktuelle Bildbreite 1200 Pixel und Höhe 800 Pixel ist und Sie wollen das 
Bildbreite zu 2400 Pixel mit dem gleichen Seitenverhältnis ändern, schalten Sie Keep Aspect 
Ratio (Seitenverhältnis) ein.  Die Applikation wird die verbleibende Dimension  berechnen. (2400 
x 1600 Pixel) 
 
Bem.: Bitte versichern Sie sich, Ihr Kunstwerk gespeichert zu haben, bevor Sie seine Bildgrösse 
ändern. Undo nach der Bildgrößenänderung ist nicht verfügbar. 
 
Copy - Kopieren Sie die Ebene zu oder aus einer dritten Partei Anwendung, die Bild mit Alpha-
Kanal in der Zwischenablage unterstützt. 
 Paste - Fügen Sie die Ebene zu oder aus einer dritten Partei Anwendung, die Bild mit Alpha-
Kanal in der Zwischenablage unterstützt. 
  



Folgende Werkzeuge arbeiten nur mit Vektorebenen, sonst sind diese Optionen ausgegraut.  
Diese Funktionen sind in Pro-Edition erhältlich. 
 
Paint Tool / Malwerkzeug - Malen Sie einen neuen Pinselstrich. Sie können einen Pinselstrich 
auf eine Vektorebene malen. 
Edit Tool / Bearbeitenwerkzeug - Bearbeiten Haupteckpunkte (gelbe Punkte) und ändern Sie 
den erstellten Vektor. Klicken Sie auf die Eckpunten (grau) um sie zu den Haupteckpunkten 
(gelb) zu wechseln.  
Group Edit Tool / Gruppenbearbeitung –Die Gruppe der Haupteckpunkten bearbeiten (gelbe 
Punkte) 
Add & Remove Tool / Hinzufügen und Entfernwerkzeug – Editierbare Eckpunte von der Flame-
linie entfernen (Tastenkürzel: STRG für Win, Cmd für Mac OS) 
Curve Transform / Kurvenbearbeitung - einen Pinselstrich vergrößern, verkleinern, drehen und 
skalieren. 
Init Curve Transform / Anfangskurve anpassen - die Anfangskurve für Pinselstrich vergrößern, 
verkleinern, drehen und skalieren. 
 
 

Layer Menu / Ebene 
 
New Layer / Neue Ebene – Neue Ebene hinzufügen. 
New Vector Layer / Neue Vektorebene – Neue Vektorebene hinzufügen (nur Pro Edition) 
Duplicate Layer / Ebene duplizieren – Aktive Ebene(n) duplizieren 
Merge Layers / Ebenen reduzieren – Ebenen in eine Ebene reduzieren 
Delete Layer / Ebene löschen – Aktive Ebene(n) löschen 
 
Show Layer / Ebene zeigen – Aktive Ebene verstecken oder zeigen 
Transform Layer / Ebene transformieren – Aktive Ebene verschieben und skalieren 
Clear Layer / Ebene leeren – Ebeneninhalt leeren 
 
Export to Photoshop / Zu Photoshop exportieren - Die Ebene mit Ebeneneinstellungen, 
Blending-modus und Opazität aus Flame Painter zu Photoshop exportieren. 
Sie finden weitere Informationen zu Flame Painter Connect - das Photoshop Plug-in nachher in 
diesem Manual.  
 
Convert to bitmap / Zu bitmap konvertieren – Vektorebene zu Bitmapebene konvertieren (nur 
Pro Edition) 
HiRes render... – Das Detail von High Resolution Renderer einstellen (1 - 5). Benutzen Sie beim 
Malen in Vektor-Ebenen. Das HiRes-Renderer ist ein polygonales Renderer. Es füllt den Raum 
zwischen Punkten und macht das Bild glatter ohne das Auftreten von Moiré-Artefakte. 
Drücken Sie die Esc-Taste, um das Rendering abzubrechen. Bitte warten Sie, bis der Prozess 
beendet. (nur Pro Edition) 

Bem.: HiRes-Renderer ist sehr rechenintensiv. Es kann eine Vektorebene noch einige Stunden 
rendern. 



Beispiel: Wenn die Vektor-Ebene besteht aus 100 000 Polygonen und Detail des HiRes-
Renderers  auf 1 gesetzt ist, kann es 1 Minute rendern.Wenn es auf 2 eingestellt ist,  
vervierfacht es die Anzahl der Polygone, so dass die Anzahl der Polygone 400 000 ist, und es 
rendert  die Ebene ca 4 Minuten. Wenn es auf 3 gesetzt ist, wird die Nummer 1 600 000  und die 
Zeit ca 16 Minuten. Wenn es auf 4 gesetzt ist, wird die Nummer 6 400 000 und die Zeit ca 64 
Minuten. Wenn es auf 5 gesetzt ist, wird die Nummer 25 600 000, und die Zeit wird 256 
Minuten, ca 4 Stunden. 
 
 

Filter Menu 
 
Blur / Unschärfe – Unschärfe-Radius in einem Pop-up-Fenster stellen 

- Preview / Vorschau - das Ergebnis in Echtzeit verstecken oder zeigen 
Glow / Glühen - Radius und Kraft des Glühen in einem Pop-up-Fenster stellen 

- Preview / Vorschau - das Ergebnis in Echtzeit verstecken oder zeigen 
 
Tile Layer / Kachelebene – Kachelt die Ebene (horizontal und vertikal) 
 
 

View Menu / Ansicht 
 
Zoom In / Einzoomen - in das Bild reinzoomen (bis 800%). 
Zoom Out / Rauszoomen - aus dem Bild herauszoomen (bis 5%) 
Zoom 100% - Bitte Zoomwert überprüfen. Beim Click auf diesem Button wird auf 100% 
gezoomt 
 
Show Cursor / Mauszeiger zeigen - Mauszeiger zeigen oder verstecken 
Show Brush Dots / Pinselpunkte anzeigen - Pinselpunkte zeigen oder verstecken 
 
 

Window Menu / Fenster-Menü 
 
Tools / Werkzeuge - Werkzeuge Fenster zeigen oder verstecken 
Palette / Farbfenster - Farbfenster zeigen oder verstecken 
Brushes / Pinsel - Pinselvoreinstellungen zeigen oder verstecken 
Layer / Ebenen – Ebenenfenster zeigen oder verstecken 
 
Stay on Top / Bleib auf der Spitze– Die Applikation bleibt immer auf der Spitze der anderen 
Applikationen. 
Fullscreen – stellt auf volle Bildschirmgröße um (klick Esc zu schließen) 
Presentation mode / Presentationmalmodus - Full screen Malmodus ohne Menüleiste (klick 
Esc zu schließen) 
  



Help Menu / Hilfe 
 
Help / Hilfe – Öffnet dieses Dokument (in Englisch) 
Send Feedback... / Feedback senden – Schicken Sie uns das Feedback – wenn Sie irgendeine 
Probleme oder Ideen haben oder wenn das Program Ihnen gefällt. Enter your email and 
message. Bitte geben Sie Ihre Email und schreiben Sie uns eine Nachricht. 
Flame Painter Website - Link auf die Webseite: 
www.escapemotions.com/products/flamepainter 
About Flame Painter – Weitere Informationen über Flame Painter, Copyright und 
Danksagungen. 
Show Brushes Folder / Brushes Ordner zeigen – Den Ordner zeigen wo die Pinseln gespeichert 
sind. 
Check for updates... - Dieser Button ist sichtbar, wenn neue Updates verfügbar sind. 
  



Flame Painter Connect 
 

Flame Painter Connect ist ein Plug-in für Photoshop CS5, CS5.5, CS6 und Photoshop CC. Es ist 
ein Live-Kommunikationskanal zwischen Photoshop und Flame Painter 3 Pro für den Austausch 
von Ebenen. 

Installation 
 

Ihres Instalattionspaket enthält 3 Ordner: 

Mac OS 
Windows 
Photoshop plugin 

 
Installation für Photoshop CS5 & CS5.5 
 
Kopieren Sie "Flame_Painter_Connect.swf"- Datei aus “Photoshop plugin”- Ordner zum 
Photoshop-Installationsordner: 
 
- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS5\Plug-ins\Panels\ 
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS5 (64 Bit)\Plug-ins\Panels\ 
- Mac OS: /Applications/Adobe Photoshop CS5/Plug-ins/Panels/ 
 
 
Installation für Photoshop CS6 & CC 
 
Schritt 1: Ӧffnen Sie “Photoshop plugin”- Ordner und doppelklicken auf 
 "Flame_Painter_Connect_1.2.zxp" - Datei. Wenn die Datei nicht mit Extension Manager 
automatisch verbunden ist, öffnen Sie Ihres Extension Manager, und wählen Sie aus dem 
Menü: File -> Install Extension. 
 
Schritt 2: Das Fenster “Extension Disclaimer” ӧffnet – klicken Sie “Accept”. 

Schritt 3: Ein Fenster öffnet - es sagt, dass ein Publisher kann nicht verifiziert werden – klicken 
Sie “Install”. 

Schritt 4: Falls Sie weitere Adobe-Produkte und Erweiterungen auf Ihrem Computer installiert 
haben, öffnet sich ein neues Fenster und erfordert, in welcher Photoshop Version Sie ein Plug-
in installieren möchten. 

Falls Extension Manager nich in Ihrem System installiert ist, oder die Pugininstallation ist nicht 
gültig, kopieren Sie manuell "Flame_Painter_Connect.swf" - Datei zum Photoshop-
Installationsordner: 



- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS6\Plug-ins\Panels\ 
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS6 (64 Bit)\Plug-ins\Panels\ 
- Mac OS: /Applications/Adobe Photoshop CS6/Plug-ins/Panels/ 

 

Flame Painter Connect Initialisierung 

 

Schritt 1: Lassen Sie beide Photoshop und Flame 
Painter 3 laufen 

Schritt 2: Erstellen Sie in Photoshop ein neues 
Dokument auf Menü: File -> New... 

Schritt 3: In Photoshop klicken Sie auf Menu: Window 
–> Extensions –> Flame Painter Connect. Eine neue 
Flame Painter Connect - Panel zeigt auf der rechten 
Seite des Bildschirms an. 
 
 
 

Ebene Austausch 
 

Export aus Photoshop zu Flame Painter 

Wählen Sie eine Ebene in Photoshop, die Sie zu Flame Painter exportieren mӧchten. Klicken Sie 
auf "PS to FP"-Taste. Wenn Sie eine leere Ebene in Flame Painter auswählen, exportiert die 
Ebene aus Photoshop in dieser leeren Ebene, ansonsten erstellt eine neue Ebene. 
 
Export aus Flame Painter zum Photoshop 

Wählen Sie eine Ebene, die Sie zu Photoshop exportieren mӧchten und klicken Sie auf Menu: 
Layer –> Export to Photoshop (Tastenkürzel: Ctrl–F für Windows, Cmd–F für Mac OS). Wenn 
Sie eine leere Ebene in Photoshop  auswählen, exportiert die Ebene aus Flame Painter in dieser 
leeren Ebene, ansonsten erstellt eine neue Ebene. 
Exportierte Ebenen halten ihre ursprünglichen Namen. Die meisten Blendingmoden kopieren 
ihre ursprünglichen Voreinstellungen auch.  



Erzeugen, Öffnen und Speichern von Bildern 
 
 

Ein neues Bild erzeugen 
 
Mit STRG+N oder über den Menüpunkt File -> New… wird ein neues Bild zu erzeugt. Ein 
Dialogfenster erscheint, in welchem man die Bildgröße und weitere Einstellungen angeben 
kann. Die Größe kann jederzeit beim Malen verändert sein. “Picture Size Info” gibt die 
Druckgröße des Bildes an. 
 
Mit dem Farbbutton Color kann man die Hintergrundfarbe auswählen.  
Bestätigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel. 
 
 

Ein Bild öffnen 
 
Mit STRG+O oder über den Menüpunkt File -> Open... öffnet man ein bestehendes Bild in 
Flame Painter. Zusätzlich können die Eigenschaften des Bildes angepasst werden.  
 
Öffnen Sie das Bild mit OK oder brechen Sie mit Cancel ab. 
 
Sie können das Bild direkt aus einer beliebigen Quelle ziehen und ablegen (Drag and Drop 
Funktion) – Es kann Ordner, Browser oder Website sein. Es öffnet sich als eine neue Ebene.  
 
 

Ein Bild speichern 
 
Über die Menüpunkte File -> Save... und File -> Save As… speichert man das Bild auf die 
Festplatte. Flame Painter nutzt ein eigenes Dateiformat mit der Endung FPA. In der Datei sind 
alle Informationen des Bildes und der Ebenen enthalten. Nutzen Sie dieses Dateiformat, wenn 
Sie später an einem bestehenden Bild weiter arbeiten möchten. 
 
Mit Flame Painter 3 Pro können Sie PSD-Dateien für Photoshop, Gimp oder andere Bitmap-
Programmen mit PSD-Dateiformatunterstützung öffnen und speichern - mit allen 
Ebeneeinstellungen, Füllmethoden(Blending Modes) und Opazität. Es ist möglich, die 
Vektorebenen als SVG-Vektor-Format-Datei in Illustrator oder anderen Vektorgrafik-Redaktion 
zu exportieren. Dort können Sie kontinuierlich Ihres Flame-Bild in Vektoren bearbeiten. 
 
Weitere Dateiformate stehen zur Verfügung, jedoch werden Detailinformationen nicht mit 
abgespeichert. Achten Sie darauf, dass sich die Hintergrundfarbe eventuell ändern könnte. 
Beispielsweise werden Transparenzinformationen nicht im JPEG-Format abgespeichert.  
 
Wenn das Bild mit spezifischen Einstellungen oder für andere Programme lesbar abgespeichert 
werden sollen, nutzen Sie die Save As..Funktion über den Menüpunkt. Das Bild lässt sich in den 
Formaten PSD, PNG, TGA, TIF, BMP oder JPG abspeichern.  
Speichern Sie das Bild mit OK oder brechen Sie mit Cancel ab.  



Veröffentlichen eigener Werke in der Online-
Galerie 

 
 

Galerie-Konto erzeugen 
 
Um eigene Werke zu veröffentlichen, ist ein eigenes Konto erforderlich. Anbei die 
Beschreibung zweier Vorgehensweisen:  
 
Aus Flame Painter heraus: 
Konto über den Menüpunkt File -> Publish Preferences erzeugen. Geben Sie Ihren Namen, E-
Mail (“Your ID”) und Passwort ein. Optional ist die Angabe der eigenen Webseite. 
 
Auf der Webseite: 
Auf der Flame Painter Gallery Webseite loggen Sie sich über login -> Create Account ein und 
geben Ihre “Your ID” (Ihre Registrierungs-E-Mail) an. Sie erhalten per E-Mail ein Passwort 
zugeschickt. 
Bem.: "Your ID" wird im Programmmenü Help->About Flame Painter angezeigt. Sollte "Your ID" 
nicht existieren, geben Sie Ihre aktuelle E-Mail-Adresse ein. 
 
 

Veröffentlichen eigener Werke 
 
Um ein eigenes Werk in der Galerie zu veröffentlichen, nutzen Sie den Menüpunkt File -> 
Publish... Geben Sie Ihrem Werk einen Namen (Artwork Name), eine Bechreibung (Description) 
und Stichwörter (Tags). Durch das Klicken des Publish Buttons wird Ihr Bild auf der Flame 
Painter Gallery Webseite (www.escapemotions.com/gallery) veröffentlicht. Die Bilder dort 
können auch nachträglich weiter bearbeitet warden. 
 
 

Galerieprofil und Bilder bearbeiten 
 
Gehen Sie auf die Gallery website, loggen Sie sich über login ein und geben "Your ID" und 
Password an. 
Im Bereich Edit Pictures können u.a. Namen, Beschreibungen und Stichwörter bearbeitet 
werden. 
Im Bereich My Profile kann das Passwort geändert warden. 
 

  

http://www.escapemotions.com/gallery


Tastenkürzel: 
 
     Windows    Mac OS 
 

New... / Neu...     STRG+N    Cmd+N 
Open.../ Öffnen...   STRG+O    Cmd+O 
Save / Speichern   STRG+S     Cmd+S 
Save As... / Speichern unter...  STRG+Shift-S    Cmd-Shift+S 
Import...    STRG+Shift+O    Cmd+Shift+O 
Publish... / Veröffentlichen...  STRG+P    Cmd+P 
Quit / Beenden   STRG+Q    Cmd+W 
 
Undo / Rückgängig   STRG+Z      Cmd+Z 
Redo / Wiederholen   STRG+Shift+Z    Cmd-Shift+Z 
Copy / Kopieren   Ctrl+C     Cmd+C 
Paste / Einfügen   Ctrl+V     Cmd+V 
Export to Photoshop   Ctrl+F     Cmd+F 
 
Brush / Pinsel      Q 
Pen Brush / Kuli Pinsel     A 
Eraser / Radiergummi     E 
Fill / Füllwerkzeug     F 
Transform / transformieren    T 
Edit Vector Layer     V 
 
Increase Value +1 / Wert um 1 vergrößern  Pfeil nach oben 
Decrease Value -1 / Wert um 1 verringern  Pfeil nach unten 
Increase Value +10 / Wert um 10 vergrößern  Bild auf 
Decrease Value -10 / Wert um 10 verringen  Bild ab 
 
Clean Layer / Ebene löschen   Del 
Move a Canvas / Canvas bewegen  Rechte Maustaste oder Leertaste+ Linke Maustaste 
 
Zoom In / Reinzoomen    STRG +     Cmd + 
Zoom Out / Rauszoomen   STRG -     Cmd - 
Zoom 100%     STRG + 0    Cmd - 0 
Zoom In | Out – Rein-/Rauszoomen   Mausrad    Mausrad 
 
Safe Boundary     STRG+B    Cmd+B 
Cursor Show | Hide – Mauszeiger zeigen/verstecken   Alt+C 
Brush Dots Show | Hide – Pinselpunkte zeigen/verstecken  Alt+D 
 
Fullscreen     STRG +L    Cmd + L 
Show Main Menu    STRG+ M    Cmd + M 
Help / Hilfe     F1     Cmd + ? 
Paint Tool / Malwerkzeug   1 
Edit Tool / Bearbeitenwerkzeug   2 
Group Edit Tool / Gruppenbearbeitung   3 
Add & Remove Tool / Hinzufügen und Entfernwerkzeug   4 
Curve Transform / Kurvenbearbeitung   5 
Init Curve Transform / Anfangskurve anpassen   6 



Personal versus Professional Version 
 
 
Personal Version eignet sich für die Nutzer, die eine vollständige Version haben möchten aber 
brauchen nicht die erweiterten Funktionen verwenden. Zusätzlich ist es den Benutzern dieser 
Version nicht erlaubt, Bilder zu verkaufen, die mit Flame Painter bearbeitet oder erzeugt 
wurden. Diese Lizenz erlaubt die Installation von Flame Painter auf mehrere Rechner eines 
Benutzers und die Nutzung des Programms für nichtkommerzielle Zwecke. 
 
Professional Version ist für die fortgeschrittenen Benutzer gedacht, die mit den erweiterten 
Funktionen wie Vektorebenen, HiRes Renderer oder Photoshopverbindung arbeiten möchten. 
Diese Lizenz erlaubt die Installation von Flame Painter auf einem einzigen Rechner für Firmen 
oder auf mehrere Rechner eines Benutzers. Diese Lizenz kann für kommerzielle Zwecke oder 
Profitaktivitäten sowie für nichtkommerzielle Zwecke genutzt werden. 
 
Weitere Details finden Sie in der vollständigen “Software License Agreement“ in Englischer 
Sprache.  



Copyright & Danksagungen 
 
 
Flame Painter © 2012-2014 Escape Motions, s.r.o 
Flame Painter © 2009-2012 Peter Blaškovič 
Flame Painter Connect © 2014 Escape Motions, s.r.o 
 
Flame Painter Team: 
 
Peter Blaškovič, Michal Fapšo, Veronika Klimeková, Andrea Vachová 
 
Unser besonderer Dank geht an: 
 
alle, die mit Ideen, Anregungen beigetragen, oder Flame Painter finalisieren geholfen, 
insbesondere Jozef Bardík, Matúš Fedorko, Daniel Kapičák, Jaroslav Kaša, Rastislav Piovarči, 
Rastislav Hornák, Gabika Ambrušová, Cara, Daniel Innes, Oto Kóňa, Tomáš Lancz, Lukáš Lancz, 
Tomáš Mišura, Andrei Oprinca, Martin Surovček, Roman Urbášek, Harvey Bunda, Rana Diaz, 
Devraj Baruah, Dennis Kirkpatrick, Jim Kanter, Gregorii Trombo, Keith Alford, Josh Kitney, Nigel 
Brewster, Vladimir Chopine, Mark S. Johnson. 
 
Übersetzungen und Korrekturen: Tanya Hayman, Tony Lloyd, Daniel Streidt, Kenjiro Nagano, 
Higashiuchi Takuri, Kévin Jorand, Marta Fernandez, Irene Briz, Andy Chen, Veronika Klimeková, 
Andrea Vachová 
 
User Interface Icons / Benutzeroberfläche Ikonen: "Batch" by Adam Whitcroft 
 
 
Libraries / Bibliotheken: 
 
Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden: 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 
CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
ImageMagick, Apache license - http://www.imagemagick.org/ 
AntiGrain Geometry 2.4, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html 
MB WebSockets, LGPL license - https://qt.gitorious.org/qtplayground/mbwebsockets 
 
 
Gott sei Dank für alle kreativen Ideen. 
  

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/
http://www.imagemagick.org/
http://agg.sourceforge.net/antigrain.com/index.html
https://qt.gitorious.org/qtplayground/mbwebsockets


Flame Painter End-User Software License Agreement 
 
 
Copyright 2012-2014 Escape Motions, s.r.o. All Rights Reserved. 
Copyright 2009-2012 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Flame Painter 
software (the "Software"). By downloading, installing, copying, or otherwise using the 
Software, you acknowledge that you have read terms and conditions of this license, 
understand them, and agree to be bound by them. If you do not agree with these terms and 
conditions, Escape Motions is unwilling to license the Software to you, and you are not 
authorized and may not use the Software. 
 
 
Permitted Use 
 
Flame Painter Personal: 
 
Users of the Flame Painter may use the Software for personal, non-commercial, or non-profit 
activities. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
Flame Painter Professional: 
 
Users of the Flame Painter may use the Software for commercial, or for-profit activities as well 
as for personal, non-commercial, or non-profit activities. 
The Software may be installed on a computer that is for multiple users but it may not be 
installed on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
 
Restrictions 
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty. This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not: 
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party. 
b, Sell, rent, lease, assign, or sublet the Software or portions thereof. 



c, Grant rights to any other person. 
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part. 
e, Use the Software in violation of any international law or regulation. 
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
 
 
Display of Copyright Notices 
 
All copyright and proprietary notices and logos within the Software files must remain intact. 
 
 
Indemnity 
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license. 
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. 
Peter Blaskovic may also make improvements and/or other changes to the Software at any 
time without notice. 
 
 
Disclaimer Of Warranty 
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT 
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE. 
 
 
Limitations Of Liability 
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH 
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING 
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 


	Flame Painter Manual
	Version 3.1 Personal | Professional
	Einführung
	Size / Größe – Pinseldurchmesser, Anzahl der malenden Pinselpunkte (1 – 300)
	Span - Pinselbreite (0 – 10)
	Dist – Pinselpunktabstand (1 – 20) – wählbar, wenn "Lines" mit "On"aktiviert ist
	Size / Größe - Pinseldurchmesser (1 – 200)
	Parameter:

